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23. VB Applications in Forest Resource Management 
 
 
 The following examples are the projects being programmed with Visual Basic: 
 

(1) Forest Harvesting Simulator 
(2) Optimal Tree-stem Bucking 
(3) Log Inventory 
(4) WVU Cruise 
(5) Proceedings of the 24th Annual COFE Meeting 
 
In this lecture, I am going to demonstrate these programs and show you some 

programming techniques. 
 
23.1 Forest Harvesting Simulator 
 
 It enables you to perform the repetitive and complex forest harvesting simulations 
under Windows and NT platforms.  The earliest version of this simulator just modeled 
one machine type – drive-to tree feller-buncher under DOS operating environment.  
Simulation was conducted by moving a physical machine model in a stand map on a 
digitizing pad.  Since the first version, we have continued to improve the simulator to 
make it comprehensive, flexible, and even easier to perform a simulation.  As new 
technologies have been introduced into computer platforms and programming tools, this 
simulator has also been upgraded consequently.   
 The current version of simulator was written with MS Visual Basic Version under 
Windows environment.  Using the newest version Forest Harvesting Simulator, you can: 
 

• Edit mapped stand 
• Generate stands 
• Simulate felling 
• Simulate skidding or forwarding 
• Monitor the traffic levels of extraction machines 
• Analyze simulations 
• Retrieve, view, and produce output of simulations 

 
 
 Forest Stand Generation 
 
 
 Random Pattern 
 
 If a random spatial pattern is requested, a ratio of the stand density to the total 
number of possible tree locations based on minimum X and Y spacing is first calculated.  
Then a random number with a uniform distribution between 0.0 and 1.0 is generated for 
each possible tree location.  If this number is less than or equal to the ratio described, the 
coordinate location is assigned a tree.  If the random number is greater than the ratio, the 
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coordinate location is considered to be unoccupied (Farrar 1981).  The minimum X and Y 
spacing are considered in this procedure when we model natural stands.  At each location, 
tree DBH is assigned randomly.  The total height and volume of that tree are then 
calculated based on the assigned DBH (Borders et al. 1990). 
  
 Uniform Pattern 
 
 All possible grids for tree locations are identified based on stand density and X 
and Y spacing.  If X and Y both meet the minimum spacing requirements, a tree location 
was assigned in the center of this X by Y rectangle.  A random variation of a half Xmin or 
Ymin was allowed in modeling both the X and Y coordinates for each tree’s location.   
 
 Clustered Pattern 
 
 When the clustered pattern is used, the number of cluster centers specified by the 
user is located randomly within a plot.  By generating the X and Y coordinates randomly 
using a pair of random numbers, each tree is provided an initial location.  The distances 
from that tree location to each of the cluster centers are determined and the nearest center 
is selected.  The distance from this center to the tree is then multiplied by a random 
number between 0.0 and 1.0 to give a new location for that tree relative to the cluster 
center (Farrar 1981).  New coordinates are then calculated for the tree and the distances 
between that location and the neighboring trees are checked to assure that minimum 
nearest distances are maintained.  If a tree location has violated the distance parameter, 
the procedure is repeated; otherwise, the location is assigned as a tree location. 
 
 Felling Operations 
 

The numerical simulation model for chain saw, feller-buncher, and harvester 
consists of two parts: (1) walk of the logger with a chain saw from tree to tree or machine 
movement from tree to tree; and (2) tree felling or processing (Figure 1).   
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Figure 1.  Flowchart of numerical felling operations. 
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Chain Saw Felling 
 
 Walk to tree, acquiring, felling, limbing, and topping are modeled for the chain 
saw.  The felling direction is first defined within a random variation range and the sawyer 
is located at one end of a plot.   Usually, the logger will move to the nearest tree to be cut 
and fell the selected tree in a narrow swath.  When the logger reaches the other end of the 
plot, he/she will return to next nearest swath.   
 
 Feller-Buncher Felling 
 
 Four functions were modeled for the drive-to-tree feller-buncher:  move to tree, 
cut the tree, move to dump, and dump.  The feller-buncher is first located at one end of 
the plot and then moves parallel to the rows of trees; the rows are 4.5- to 6-meter wide.  
Marked trees on either side of the machine are removed.  When the machine reaches the 
end of the row, it turns around and cuts another tree in the nearest swath, continuing until 
the plot is finished.  The system searches for the “cut” tree and adds the tree to the felling 
head.  A solid black circle at the location of cut tree will be drawn to signify the stump.  
This procedure is repeated until the head is full.  The system then moves the machine 
image to the location of the bunch to be built and drops the trees.   
 
 Harvester Felling  
 

Six functions were modeled for the cut-to-length harvester:  move, boom 
extend/retreat, cut, swing boom, processing, and dumping.  Unlike the feller-buncher, a 
harvester with a boom can reach several trees at a stop. Trees could be felled and 
processed with the same harvester.  A circle around the harvester is drawn to indicate the 
reach range of the boom.  This circle is moved as the harvester moves.  The harvester 
usually runs in a straight trail and works in a 12- to 15-meter wide strip depending on the 
boom reach.  Trees on the trail must be removed for machine travel.  Trees on either side 
of the machine within the boom reach can be removed based on the user’s choice of 
harvest method.  The processed trees are then dropped on either side of harvester trail for 
later forwarding.  
  
 
 Extraction Simulation 
 
 
 Extraction Patterns 
 
 In an interactive skidding simulation, a landing must be located first in the 
logging area that was created by felling a plot a fixed number of times.  Tree or log pile 
data are provided by the felling simulation.  The skidder machine will begin at the 
landing at the nearest tree pile and then move to the next closest pile until it is fully 
loaded.  Then the loaded machine will travel back to the landing.  While the forwarder is 
simulated in a similar manner, it follows the harvester’s trail and loads logs with a self-
mounted boom. 
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 Although interactive simulation allows constant and direct human input to the 
simulation, it is time consuming and often repetitive, especially with respect to uniform 
skidding or forwarding patterns.  As a result, a numerical skidding or forwarding 
simulation was modeled in the system (Figure 2).  To date, four skidding or forwarding 
patterns (SP1, SP2, SP3, and FP1) have been modeled (Figure 3): 
 SP1 - freestyle skidding (no designated skid trail) 
 SP2 - skid trail runs through the center of plot (one trail) 
 SP3 - skid trails traveling from the landing to the corners of plot (two trails) 
 FP1 - forwarding along the trails of the harvester (forwarding direct to road) 

The program also allows the user to choose the landing location and the machine 
payload.  The landing must be located before performing a simulation.  The machine will 
begin at the landing and move to the nearest tree bunch or log pile, and then move to the 
next nearest one until it is fully loaded.  The machine then follows the specified 
extraction pattern throughout the entire simulation process. 
 
 Traffic Intensity 
 
 The traffic intensity within each smaller grid, e.g., 5 by 5 meters is recorded into a 
file while the numerical extraction simulation is being performed.  Four travel intensity 
categories for a skidder or forwarder were defined in the system (Carruth and Brown 
1996): 
 TI1  -  Trees on the plot have been felled. 

   TI2  -  Trees that stood on the plot have been removed and no other traffic has  
    passed through the plot. 
   TI3  -  Trees that stood on the plot have been removed and trees outside the plot  

 have been skidded through the plot.  There have been 3 to 10 passes with a 
loaded machine.  

 TI4  -  There have been more than 10 passes with a loaded machine through the 
plot. 
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Figure 2.  Flowchart of numerical extraction simulation. 
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Figure 3.  Diagram of extraction patterns. 
 
 After the machine is fully loaded, it will begin to return from its current position 
to the landing by the shortest and easiest route depending on the extraction pattern.  The 
skidding area is divided into cells (5 by 5 meters) for accurate recording of travel 
intensity.  This grid width allows two machines to pass each other on a trail.  There are 
eight possible direction options for a machine to move from its current position to the 
next position. 
 This procedure was repeated until the end point (Xi, Yi) was reached.  The 
number of passes was recorded and accumulated for each grid that the loaded machine 
passed through as we traced from start point to end point.  The travel intensity category in 
each grid is displayed in four colors depending on the intensity level.  After the tracking 
is completed along the entire line segment, the number of passes for the loaded machine 
in each grid is stored in computer memory and saved to a file after the simulation is 
completed. 
 

Simulation Example 
 
 A natural hardwood stand in central Appalachia was generated so as to illustrate 
the performance of the stand generation and harvesting simulation.  Assuming the species 
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composition is yellow poplar 40%, black cherry 18%, red maple 16%, red oak 15%, and 
other hardwoods 11%.  The stand density is 485 trees per hectare with DBH range from 5 
to 110 cm and plot size is 0.16-hectare.  It is also assumed that the stand is about 75 years 
old and trees are randomly distributed. 
  

Once the above information is entered, a 2D stand map is first generated and 
displayed (Figure 4a).  Three smaller windows are used to display the stand information, 
color legends for species, and the DBH distribution by species or for overall species.  
Meanwhile a stand map data file is created and saved in the system.  The 3D stand map 
could be displayed by changing the display mode.  Some functionality could be 
performed on the 3D stand map.  For example, the image could be rotated from left or 
right continuously to allow for examination of the stand structure from different 
directions.  The user could also change the crown height and diameter by using the “tree 
design” module.  In order to differentiate species on the map, a unique color is randomly 
generated and assigned to each species.  Additionally, the tree height and DBH are also 
drawn to scale for better visualization. 

   
Two projection modes (perspective projection and parallel projection) and three 

view modes (projective view, profile view, and overhead view) can be produced by the 
system.  Perspective projection and projective view are the default projection mode and 
view mode, respectively (Figure 4b).  Overhead view and profile view can be enabled by 
changing the view mode (Figure 4c and d).  The 3D component can also allow the user to 
mark trees to be harvested (Figure 4e).  Trees can be marked by species, DBH, or both, or 
by the user’s specified requirements such as marking diseased or poorly formed trees.  
The marked trees can then be felled (Figure 4f and g), and extracted from the plot (Figure 
4h).   

 
The system saves the operation data into the database for later analyses once a 

simulation run is complete.  The analysis module of harvesting simulator can analyze the 
generated stand and compare it with a thinned or partially cut stand.  This module 
provides: (1) elemental time summary, (2) machine summary by cycle, (3) summary of 
harvested stand and extracted site, and (4) production analysis as well as traffic intensity 
of extraction machines across the site. 
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Figure 4.  Stand generation and harvesting simulation. 
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24.2 WVU Cruising 
 
 WVU Cruising is especially designed to analyze the field cruising data and 
provide the results in the format of MS Access report.   
 

Field Cruising Data 
 

The field cruising data should be in the format of MS Excel.  In order to import 
the Excel data to WVU Cruise, you need to do the following things: 

(1) Open the Excel file that contains the cruising data.  The data must contains the 
fields of Plot#, Species (Spp), DBH, merchantable height in number of logs 
(MHT), Pulp, Grade, and total height in feet (HGT).  These fields must be in the 
proper order.  If you have no data for one or more fields, put 0s in the cells. 

 

 
Figure 5.  Format of cruise data. 

 
(2) Create a Named Range, DataRange, in your Excel spreadsheet 

a. Highlight the row(s) and column(s) area where your data resides. 
b. On the Insert menu, point to Name, and click define. 
c. Enter the name DataRange for the Named Range name. 
d. Click OK. 
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Figure 6.  Define a data range associated with data object. 
 

(3) Now, start WVU Cruise program, the main MDI form is displayed first.  On the 
menu bar, there are File, Report, Tools, and Help menus. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 7.  Menu and toolbars of WVU Cruise. 
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Import Data 
 

(1) In the Tools menu, click Import, a dialog window is popped up for importing 
Excel data into the cruising program.  Once the file is selected, click OK. 

 
 
 
 

 
 
 
 
  
  
 
 
 
 
Figure 8.  Import Excel data to WVU Cruise. 
 

Load Data 
 

(1) Now you can load the cruising data in the program.  In the File menu, click Open, 
the cruising data will be loaded for analyses. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 9.  Load cruise data for analysis. 
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(2) You can browse the data loaded.  You should notice there are “View Species and 
Grade” and “Cruise Design” buttons on the form. 

 
Cruise Design 

 
If the user clicks the “Cruise Design” button, a design form will be popped up. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 10.  Cruise design window. 
 
In this design window, you can: 
 

(1) Design and save cruising information for report header.  Simply enter the required 
text boxes and then click “Save Cruise Info”. 

(2) Select form class for a specific species.  Click “Girard Form Class”, a form is 
displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
Figure 11.  Edit Girard form class by species. 
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(3) Configure plot.  You can use fixed area, variable radius plot, or 100% tally. 
(4) Summarize cruising data by: 

a. Volume 
b. Plot 
c. Cruise statistics 
d. Stand/stock table 

i. DBH class 
ii. Species and DBH 

iii. Grade, species, and DBH 
 
 

Report 

 The summarized cruising data can be outputted in the format of Access:  
(1) By Volume - Two parts of volume summary are provided: merchantable 

volume tract summary and merchantable volume per acre summary, which are 
saved in the database and then reported.   

(2) Plot level result is also provided.  Once the data are saved, a report by plot 
will be generated. 

(3) The cruising statistics are also provided for volume per acre in cubic foot 
(CFV), in International Board foot (1/4) (IBFV), in Doyle (DBFV), trees per 
acre (TPA), and basal area per acre (BA/A).  Statistics include mean, standard 
deviation, standard error, variance, coefficient of variance (CV), confidence 
interval at 95% level, percent of error, and sample size.  The sample size will 
be especially useful for later cruising design. 

(4) The Stand/Stock table report can be reported in three levels by DBH class, 
Species and DBH, and Grade, species, and DBH.   

 
 

Programming 
 
(1) Input data – convert MA Excel data into Access format then load then into the 

memory. 
 
 

Dim xlBook As Excel.Workbook 
Dim rgSpp As Range 
 
 
Private Sub Command1_Click() 
     
    On Error GoTo err_Handler 
     
    Dim filePath As String 
    Dim i, j, nExcelData As Integer 
    Dim DataConn As ADODB.Connection 
    Dim rdExcelData As ADODB.Recordset 
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    If Right(File1.Path, 1) <> "\" Then 
        filePath = File1.Path & "\" & File1.fileName 
   Else 
        filePath = File1.Path & File1.fileName 
    End If 
 
    Set DataConn = New ADODB.Connection 
     
    Path = filePath 
    DRIVER = "{Microsoft Excel Driver (*.xls)}" 
    Db = "DBQ=" & Path & ";" 
    Db = Db & "DefaultDir=" & Path & ";" 
    Db = Db & "Driver=" & DRIVER & ";" 
    DataConn.Open Db 
    ChDir App.Path 
    Set rdExcelData = DataConn.Execute("SELECT * FROM DataRange") 
     
        Set dbCruzData = OpenDatabase("dbCruzData.mdb") 
        Set rdCruzData = dbCruzData.OpenRecordset("tblAllTree1") 
        Call ClearTreeTable(rdCruzData) 
     
    If rdExcelData.EOF Then 
        MsgBox "No data can be loaded from this empty file!" & Chr(13) & filePath, 
vbOKCancel + vbInformation, "Excel Conversion" 
        Exit Sub 
    Else 
        j = 0 
        nExcelData = 0 
        Do While Not rdExcelData.EOF 
            nExcelData = nExcelData + 1 
            rdExcelData.MoveNext 
        Loop 
        frmCruzProg.Show 
        frmCruzProg.Caption = "Importing cruising data ... " 
        frmCruzProg.CruzProgBar.Max = nExcelData 
        Screen.MousePointer = vbHourglass 
        rdExcelData.MoveFirst 
        Do While Not rdExcelData.EOF 
            i = 0 
            j = j + 1 
            frmCruzProg.CruzProgBar.Value = j 
            rdCruzData.AddNew 
            For Each Field In rdExcelData.Fields 
                 rdCruzData.Fields(i) = Field.Value 
                 i = i + 1 
            Next 
            rdCruzData.Update 
            rdExcelData.MoveNext 
        Loop 
    End If 
    Set rdExcelData = Nothing 
    Unload frmCruzProg 
    Screen.MousePointer = vbDefault 
     
    Exit Sub 
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err_Handler: 
    Call Error_Handler 
 
End Sub 
 
 

 
(2) Process data – use arrays to hold the data and then compute trees per acre, 

basal area, and volume by species, dbh, and others. 
 

‘Assign cruising data to arrays for processing 
Public Sub AssignCruiseData() 
     
    On Error GoTo err_Handler 
     
    Dim i As Integer 
    i = 1 
     
    frmCruzProg.CruzProgBar.Max = nRecord 
    Screen.MousePointer = vbHourglass 
    'nRecord = rdCruiseData.RecordCount 
    ReDim Preserve PointNo(nRecord), Species(nRecord), DBH1(nRecord), Height(nRecord), 
PulpW(nRecord), Grade(nRecord), THeight(nRecord) 
    ReDim SPPCruised(NofSpecies), PointCR(NofPoint), DClassCR(NofDClass), 
GradeCR(NofGrade) 
    rdCruzData.MoveFirst 
    While Not rdCruzData.EOF 
        frmCruzProg.CruzProgBar.Value = i 
         PointNo(i) = rdCruzData("PointID") 
         If IsNull(rdCruzData("Species")) Then 
            Species(i) = "None" 
        Else 
            Species(i) = rdCruzData("Species") 
        End If 
         'Species(i) = CSpecies(Species(i)) 
         If IsNull(rdCruzData("DBH")) Then 
            DBH1(i) = 0 
         Else 
            DBH1(i) = rdCruzData("DBH") 
         End If 
         If IsNull(rdCruzData("MHT")) Then 
            Height(i) = 0 
         Else 
            Height(i) = rdCruzData("MHT") 
         End If 
         If IsNull(rdCruzData("Pulp")) Then 
            PulpW(i) = 0 
         Else 
            PulpW(i) = rdCruzData("Pulp") 
         End If 
         If IsNull(rdCruzData("Grade")) Then 
            Grade(i) = "None" 
         Else 
            Grade(i) = rdCruzData("Grade") 
         End If 
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         If IsNull(rdCruzData("THT")) Then 
            THeight(i) = 0 
         Else 
            THeight(i) = rdCruzData("THT") 
         End If 
        'Debug.Print Point(i), Species(i) 
         i = i + 1 
         rdCruzData.MoveNext 
    Wend 
     
    'Assign species 
    i = 1 
    rdSpecies.MoveFirst 
    While Not rdSpecies.EOF 
        If IsNull(rdSpecies("Species")) Then 
            SPPCruised(i) = "None" 
        Else 
            SPPCruised(i) = rdSpecies("Species") 
        End If 
        'Debug.Print SPPCruised(i) 
        i = i + 1 
        rdSpecies.MoveNext 
    Wend 
    'Assign plot 
    i = 1 
    rdNofPlot.MoveFirst 
    While Not rdNofPlot.EOF 
        If IsNull(rdNofPlot("PointID")) Then 
            PointCR(i) = 0 
        Else 
        PointCR(i) = rdNofPlot("PointID") 
        End If 
        'Debug.Print PointCR(i) 
        i = i + 1 
        rdNofPlot.MoveNext 
    Wend 
    'Assign DBH class 
    i = 1 
    rdDBHClass.MoveFirst 
    While Not rdDBHClass.EOF 
        If IsNull(rdDBHClass("NofDClass")) Then 
            DClassCR(i) = 0 
        Else 
            DClassCR(i) = rdDBHClass("NofDClass") 
        End If 
        i = i + 1 
        rdDBHClass.MoveNext 
    Wend 
    'Assign grade 
    i = 1 
    rdNofGrade.MoveFirst 
    While Not rdNofGrade.EOF 
        If IsNull(rdNofGrade("Grade")) Then 
            GradeCR(i) = "None" 
        Else 
            GradeCR(i) = rdNofGrade("Grade") 
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        End If 
        i = i + 1 
        rdNofGrade.MoveNext 
    Wend 
     
    blCallAssignCruz = True 
     
    Unload frmCruzProg 
    Screen.MousePointer = vbDefault 
     
    Exit Sub 
 
err_Handler: 
    Call Error_Handler 
     
End Sub 
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24.3 CD-Based Proceedings 
 
 This is a relatively smaller project compared to previous ones.  The basic idea is 
to develop an autorun CD to allow the users to read papers and other materials related to 
the meeting.  In addition to using regular VB controls, the Microsoft Internet Control 
(Web browser) is used in this project.  
 
 This is CD-based proceedings of the 24th Annual Meeting of the Council on 
Forest Engineering.  The proceedings were compiled as an auto run program that was 
written with MS VB.   
 
 The CD contains the following files: 
 
 Cofe24.exe             A compiled executable that is used to load the proceedings. 

autorun.inf             Used to run Cofe24.exe automatically. 
 Msvbvm60.dll      A Microsoft VB virtual machine DLL. 
 VBRun60.exe        This file is used to install MS VB runtimes on client's 

machine. 
 README.txt         Instruction file.  
 

 
Figure 12.  Start window of the proceedings. 
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Figure 13.  The main window of the proceedings. 
 
The important things are the methods with Internet Control: 
 

- Navigate 
- GoBack 
- GoForward 
- GoHome 
- Refresh 
- Stop 
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Figure 14.  Browse a paper by author. 
 
 
 

Option Explicit 
 
Public StartingAddress As String 
Dim mbDontNavigateNow As Boolean 
Dim eQuery As OLECMDF 
 
 
Private Sub cboCOFEBy_Click() 
 
    On Error Resume Next 
    If cboCOFEBy.Text = "Meeting Information" Then 
        Call ShowCOFENews(lstCOFE24Tab) 
    ElseIf cboCOFEBy.Text = "Paper By Author" Then 
        Call ShowCOFEAuthor(lstCOFE24Tab) 
    ElseIf cboCOFEBy.Text = "Paper By Title" Then 
        Call ShowCOFEPaperTitle(lstCOFE24Tab) 
    End If 
     
 
End Sub 
 
Private Sub cmdBack_Click() 
 
    On Error Resume Next 
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    mainCOFEBrowser.GoBack 
     
End Sub 
 
 
Private Sub cmdForward_Click() 
 
    On Error Resume Next 
     
    mainCOFEBrowser.GoForward 
        
End Sub 
 
Private Sub cmdHome_Click() 
 
    On Error Resume Next 
     
    'mainCOFEBrowser.GoHome 
    mainCOFEBrowser.Navigate App.Path & "\Cofe24\COFE24Home.htm" 
   
End Sub 
 
Private Sub cmdPrint_Click() 
     
    On Error Resume Next 
     
    eQuery = mainCOFEBrowser.QueryStatusWB(OLECMDID_PRINT)  'get print command 
status 
    If Err.Number = 0 Then 
            If eQuery And OLECMDF_ENABLED Then 
                mainCOFEBrowser.ExecWB OLECMDID_PRINT, 
OLECMDEXECOPT_PROMPTUSER, "", ""    'Ok to Print? 
          Else 
                MsgBox "The Print command is currently disabled." 
            End If 
    End If 
 
End Sub 
 
Private Sub cmdRefresh_Click() 
 
    On Error Resume Next 
     
    mainCOFEBrowser.Refresh 
     
End Sub 
 
Private Sub cmdStop_Click() 
     
    On Error Resume Next 
    mainCOFEBrowser.Stop 
    Me.Caption = mainCOFEBrowser.LocationName 
     
End Sub 
 
Private Sub Form_Load() 
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    On Error Resume Next 
    ChDir App.Path 
    Me.Show 
    Form_Resize 
 
    If Len(StartingAddress) > 0 Then 
        cboAddress.Text = StartingAddress 
        cboAddress.AddItem cboAddress.Text 
        'try to navigate to the starting address 
        mainCOFEBrowser.Navigate StartingAddress 
    End If 
         
    cboCOFEBy.AddItem "Meeting Information" 
    cboCOFEBy.AddItem "Paper By Author" 
    cboCOFEBy.AddItem "Paper By Title" 
    cboCOFEBy.Text = "Meeting Information" 
    mainCOFEBrowser.Navigate App.Path & "\Cofe24\COFE24Home.htm" 
    Call ShowCOFENews(lstCOFE24Tab) 
    lstCOFE24Tab.ToolTipText = "Double click to display the item." 
    cmdBack.ToolTipText = "Back" 
    cmdForward.ToolTipText = "Forward" 
    cmdStop.ToolTipText = "Stop" 
    cmdRefresh.ToolTipText = "Refresh" 
    cmdHome.ToolTipText = "Home" 
    cmdPrint.ToolTipText = "Print" 
    cmdClose.ToolTipText = "Close" 
     
     
End Sub 
 

            Private Sub Form_Resize() 
     
    On Error Resume Next 
     
    cboAddress.Width = Me.ScaleWidth - 100 
    mainCOFEBrowser.Width = Me.ScaleWidth - 3100 
    mainCOFEBrowser.Height = Me.ScaleHeight - (picAddress.Top + picAddress.Height) - 100 
    lstCOFE24Tab.Height = Me.ScaleHeight - (picAddress.Top + picAddress.Height) - 400 
    fraCmdButton.Width = Me.ScaleWidth - 100 
    cmdPrint.Left = Me.ScaleWidth - 2200 
    cmdClose.Left = Me.ScaleWidth - 1200 
 
End Sub 
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